
Query Management Facility

Getting Started with QMF for Windows
Version 6

SC26-9582-02

IBM



Note!
Before using this information and the product it supports, be sure to read the general information under
“Appendix. Notices” on page 55.

Fourth Edition (March 2000)

This edition applies to Query Management Facility for Windows, a feature of Version 6 of DB2 Universal Database
Server for OS/390 (DB2 UDB for OS/390), 5645–DB2 , and of Query Management Facility, a feature of Version 6 of
DATABASE 2 Server for VM and VSE (DB2 for VM and VSE), 5648–A70, and of Query Management Facility for
Windows, 5697–E35, and of Query Management Facility for Windows, a feature of Version 6 of DB2 Universal
Database for AS/400, 5697–G04, and to all subsequent releases and modifications until otherwise indicated in new
editions.

This edition replaces and makes obsolete the previous edition, SC26-9582-01. The technical changes for this edition are
indicated by a vertical bar to the left of the change. Editorial changes that have no technical significance are not
noted.

© Copyright International Business Machines Corporation 1997, 2000. All rights reserved.
US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract
with IBM Corp.



Contents

The QMF Library . . . . . . . . . . v

Chapter 1. Introduction . . . . . . . . 1
Database servers . . . . . . . . . . . 1

DB2 family of databases . . . . . . . 1
User name vs. technical name . . . . . 1
Setting the server name . . . . . . . 1

Database Security . . . . . . . . . . 2
Logging on. . . . . . . . . . . . 2
Correcting passwords . . . . . . . . 3
Changing passwords . . . . . . . . 3
Specifying accounting strings. . . . . . 4

Governing . . . . . . . . . . . . . 4
Viewing resource limits . . . . . . . 4
Setting your own row limit . . . . . . 5

Customizing the toolbar (32-bit version only) . 5
Adding buttons to the toolbar . . . . . 5
Moving buttons on the toolbar . . . . . 6
Removing buttons from the toolbar . . . 6

Chapter 2. Working with SQL queries . . . 7
SQL Queries . . . . . . . . . . . . 7

Creating new SQL queries. . . . . . . 7
Running SQL queries at a database server . 7
Switching between the Results view and the
SQL view . . . . . . . . . . . . 7
Selecting columns and rows . . . . . . 8
Resizing columns and rows . . . . . . 8
Auto fitting columns and rows . . . . . 8
Sorting query results . . . . . . . . 9

Working with Fonts . . . . . . . . . . 9
Selecting the query display font . . . . . 9
Selecting the query results display font . . 9

Multiple queries . . . . . . . . . . 10
Displaying multiple queries
simultaneously . . . . . . . . . . 10

Drawing Queries . . . . . . . . . . 10
Creating new SQL queries . . . . . . 11

Substitution Variables in SQL Queries . . . 12
Running SQL queries with substitution
variables . . . . . . . . . . . . 12

Saving SQL Queries . . . . . . . . . 13
Saving SQL queries to files . . . . . . 13
Opening saved SQL query files . . . . 13
Saving SQL queries at the database server 13

Opening saved SQL queries at the
database server . . . . . . . . . . 14

Printing SQL Queries and Results . . . . . 14
Previewing a query . . . . . . . . 14
Previewing query results . . . . . . . 15
Printing SQL queries . . . . . . . . 15
Printing query results . . . . . . . . 15

Chapter 3. Building Prompted Queries . . 17
Building simple queries . . . . . . . . 17

Opening new prompted queries . . . . 17
Prompted query action buttons . . . . 17
Adding tables to prompted queries . . . 18
Running prompted queries . . . . . . 18

Building Complex Queries . . . . . . . 19
Adding columns to prompted queries . . 19
Using sort conditions . . . . . . . . 19
Adding sort conditions . . . . . . . 20
Using row conditions . . . . . . . . 20
Adding row conditions . . . . . . . 21
Using multiple tables in prompted queries 21
Creating prompted query join conditions 22

Prompted queries and SQL . . . . . . . 22
Viewing SQL for prompted queries . . . 22
Converting prompted queries to SQL . . 22

Using Substitution Variables in Prompted
Queries . . . . . . . . . . . . . 23
Saving Prompted Queries . . . . . . . 23

Saving prompted queries to files . . . . 23
Opening saved prompted query files. . . 23
Saving prompted queries at the database
server . . . . . . . . . . . . . 23
Opening saved prompted queries at the
database server . . . . . . . . . . 24

Printing Prompted Queries . . . . . . . 24
Previewing prompted queries . . . . . 24

Chapter 4. Building Reports . . . . . . 27
Forms . . . . . . . . . . . . . . 27

Understanding Forms . . . . . . . . 27
Producing a report using a form . . . . 28
Editing a form . . . . . . . . . . 28

Creating a form . . . . . . . . . . . 28
Step 1: Create a form . . . . . . . . 29
Step 2: Change the Column Order . . . 29

© Copyright IBM Corp. 1997, 2000 iii



Step 3: Change the Column Headings . . 29
Step 4: Change the Column Format . . . 29
Step 5: Add Summary Information . . . 30
Step 6: Add Page Headers and Footers . . 30

Saving Forms . . . . . . . . . . . 31
Saving a form to a file . . . . . . . 31
Opening saved form files . . . . . . 31
Saving forms at the database server . . . 31
Opening saved forms at the database
server . . . . . . . . . . . . . 32

Printing Reports . . . . . . . . . . 32
Exporting Reports . . . . . . . . . . 32

Chapter 5. Working with procedures . . . 35
Running procedures . . . . . . . . . 35

Creating a new procedure . . . . . . 35
Running a procedure at a database server 35

Saving procedures . . . . . . . . . . 35
Saving procedures to files . . . . . . 35
Opening a saved procedure file . . . . 36
Saving a procedure to the database server 36
Opening saved procedures at the database
server . . . . . . . . . . . . . 36

Printing procedures . . . . . . . . . 37
Previewing a procedure . . . . . . . 37
Printing a procedure . . . . . . . . 37

Chapter 6. Working with Lists . . . . . 39
Objects . . . . . . . . . . . . . . 39

Listing objects . . . . . . . . . . 39
List window commands . . . . . . . . 40

Display object . . . . . . . . . . 40
Run object . . . . . . . . . . . 40
Draw object . . . . . . . . . . . 40
Edit object . . . . . . . . . . . 40
Properties . . . . . . . . . . . . 40

Creating lists . . . . . . . . . . . . 40
Removing objects from lists . . . . . . 40
Saving lists to files . . . . . . . . . 41

Opening saved list files . . . . . . . 41

Chapter 7. Working with static queries . . 43
Static queries. . . . . . . . . . . . 43

Creating static queries. . . . . . . . 43
Replacing substitution variables with host
variables . . . . . . . . . . . . 44
Running a static query . . . . . . . 45

Chapter 8. Working with the Table Editor 47
Table Editor . . . . . . . . . . . . 47

Searching for rows using the table editor 47
Adding a row . . . . . . . . . . 48
Changing a row. . . . . . . . . . 48
Deleting a row . . . . . . . . . . 48

Editing tables from the query results view . . 49
Deleting a row from the query results view 49
Updating columns from the query results
view . . . . . . . . . . . . . 49

Chapter 9. Distributing Data . . . . . . 51
Exporting Data . . . . . . . . . . . 51

Exporting data to files . . . . . . . 51
Importing data . . . . . . . . . . 52
Saving data to a database server . . . . 52

Using the Microsoft Excel Add-In . . . . . 53
Using the Lotus 1-2-3 Add-In . . . . . . 54
Using Sample Applications . . . . . . . 54
Building an Application Using the QMF for
Windows API . . . . . . . . . . . 54

Appendix. Notice s . . . . . . . . . 55
Trademarks . . . . . . . . . . . . 57

Index . . . . . . . . . . . . . . 59

Readers’ Comments — We’d Like to Hear
from You . . . . . . . . . . . . . 61

iv QMF: Getting Started with QMF for Windows



The QMF Library

You can order manuals either through an IBM representative or by calling
1-800-879-2755 in the United States or any of its territories.
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Chapter 1. Introduction

This chapter provides an overview of QMF for Windows and explains some
of the basic tasks for getting started with QMF for Windows.

Database servers

Queries, forms, procedures, and tables are run and saved at a database server.

DB2 family of databases
QMF for Windows can connect to a wide range of DB2 databases.
v DB2 UDB for OS⁄390, DB2 for OS⁄390, and DB2 for MVS
v DB2 Server for VSE & VM and SQL⁄DS
v DB2 Universal Database and DB2 Common Server
v DB2 Parallel Edition
v DataJoiner

Your QMF for Windows license determines which DB2 family products you
can install on and connect to with your copy of QMF for Windows.

User name vs. technical name
Different versions and types of DB2 refer to a database by an RDB name,
location name, or some other technical name.

With QMF for Windows your administrator can assign an easier to remember
user name to a database name, for example, Purchasing Database instead of
DB2P_01_PURCH.

QMF for Windows refers to a database server or a DB2 database as a "server."

Setting the server name
Before you can query a database, QMF for Windows needs to know where the
database is stored.
1. From the File menu, click New SQL Query. A new SQL query document

opens.
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2. From the Query menu, click Set Server. The Set Server dialog box opens.

3. From the list of available servers, select the one that you want to query
and click OK. When you begin your next QMF for Windows session, QMF
for Windows automatically reconnects to the same server.

Database Security

You must provide a user ID and password before you can connect to a server.

Logging on
You must specify a valid user ID and password for the database server that
you are trying to access. The database server user ID and password is not
necessarily the same as your local or network user ID and password.

If you are running Windows for Workgroups or Windows 9x, you have the
option of remembering server passwords across QMF for Windows sessions. If
you are currently logged on to Windows, the Set User Information dialog box
displays an additional check box labeled Remember this password?. If you
select this check box, then the password you enter for that server is stored in
the Windows password list. Whenever you are logged on to Windows, QMF
for Windows can automatically retrieve that password so that you are not
prompted. If you are not logged on when you run QMF for Windows, or if
you are logged on as a different user, QMF for Windows prompts you for a
user ID and password.

Note: If you choose to save a password, anyone who can log on to your
Windows for Workgroups or Windows 9x account can access your
database servers with your (server) user ID and password.
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1. From the Query menu, select Set User Information. The Set User
Information dialog box opens.

2. Enter your user ID and password in the appropriate fields.

Note: The user ID and password are case sensitive, for example, if your
user ID or password is uppercase, you must enter it in uppercase.
Some types of database servers treat user IDs and passwords as
case sensitive; others do not.

3. Check Remember this password? if you want to save your user ID and
password.

4. Click OK. QMF for Windows stores this information in preparation for
accessing the server.

Correcting passwords
If you entered an incorrect password, you can correct the error by reopening
the Set User Information dialog box.
1. From the Query menu, click Set User Information. The Set User

Information dialog box appears.
2. Type the password again and click OK. The password is corrected.

Changing passwords
You can change your password at the database server from QMF for
Windows. This feature is currently supported only by DB2 for OS⁄390 Version
5 and later.
1. From the Query menu, click Set User Information. The Set User

Information dialog box opens.
2. Click Change. The New password and Confirm new password fields

appear.
3. Type your new password in the New password and Confirm new

password fields and click OK. Your database server password is changed.
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Specifying accounting strings
The database server uses accounting strings to track system usage. Ask your
database administrator to find out if your system uses accounting strings.
1. From the Query menu, click Set User Information. The Set User

Information dialog box opens.
2. In the Accounting string field, type the accounting string you want to use

and click OK. QMF for Windows stores the information in preparation for
accessing the server.

Governing

The QMF for Windows governor is always running in the background,
monitoring the usage of database and system resources. The governor also
limits the type and size of queries you can run.

Viewing resource limits
From the View menu, click Resource Limits. The Resource Limits dialog box
opens. All information in the Resource Limits dialog box is read only. Your
system administrator sets these limits.

4 QMF: Getting Started with QMF for Windows



The types of limits and controls that can be in effect are:
v Timeouts
v Limits
v SQL Verbs
v Options
v Save Data
v Binding
v Object Tracking

Setting your own row limit
You can specify the maximum number of rows to retrieve for this query.
When this limit is reached, QMF for Windows cancels the query. The
maximum authorized row limit specified in your resource limits group takes
precedence over this parameter.

Enter 0 to specify no limit in this field.

Rows that QMF for Windows has already retrieved in excess of this limit are
retained and available for viewing.
1. From the Query menu, click Set Row Limit. The Set Row Limit dialog box

displays.

2. Enter the maximum number of rows that you want the query to return
and click OK. The row limit is applied the next time you run the query.

Customizing the toolbar (32-bit version only)

You can customize the toolbar to display only the buttons that you want to
see.

Adding buttons to the toolbar
You have the option of adding buttons to the existing QMF for Windows
toolbar. These buttons represent functions that not all users may need, but
that are available for inclusion in the toolbar.
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1. Double-click the gray area surrounding the toolbar. The Customize Toolbar
dialog box opens.

2. From the Available buttons column, select the button that you want to
add and click Add. The button is added to the toolbar.

3. When you finish adding buttons, click Close. The dialog box closes and
the new buttons are added to the toolbar

Moving buttons on the toolbar
You have the option of rearranging the buttons on the QMF for Windows
toolbar.
1. Double-click on the gray area surrounding the toolbar. The Customize

Toolbar dialog box opens.
2. From the Toolbar buttons column, select the button that you want to

move.
3. Use the Move Up and Move Down buttons to move the button within the

toolbar.
4. When you finish moving buttons, click Close. The dialog box closes and

the buttons appear in their new locations.

Removing buttons from the toolbar
You have the option of removing buttons from the QMF for Windows toolbar.
1. Double-click on the gray area surrounding the toolbar. The Customize

Toolbar dialog box opens.
2. From the Toolbar buttons column, select the button that you want to

remove and click Remove. The button is removed from the toolbar.
3. When you finish removing buttons, click Close. The dialog box closes and

the buttons are removed from the toolbar.
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Chapter 2. Working with SQL queries

This chapter is intended for all users. After completing this chapter, you can
write and run queries and view and scroll through query results.

Structured Query Language (SQL) is the most basic interface between a user
and a database. Queries are written in SQL and processed by the database.
Users can write QMF for Windows queries in SQL, or create queries using the
"point and click" method.

SQL Queries

Structured Query Language queries require knowledge of the commands and
syntax of SQL. Users unfamiliar with SQL should try creating Prompted
queries.

Creating new SQL queries
Click the New SQL Query button on the toolbar.

A new query document opens.

Running SQL queries at a database server
1. Open a new query document and type in a query, or open an existing

query file, or open a query from the database.
2. Click the Run Query button on the toolbar.

The query runs and the results are displayed.

Switching between the Results view and the SQL view
You can look at either the results of a query or the SQL statement itself.

From the SQL view of a query that has been run, click the View Results
button on the toolbar.
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The query results are displayed.

-or-

From the Results view of a query, click the View SQL button.

The SQL statement is displayed.

Selecting columns and rows
Once you have run a query, you can use the controls in the Results view to
edit and select information.

Column and row selectors Appearance Function

Row selector Click to select all the data in a row.

Column selector Click to select all the data in a column.

Cell Click directly on the cell to select it.

Scroll-to-bottom and Scroll-to-top
buttons

Click to scroll to the top or bottom of a set
of query results.

Resizing columns and rows
You can change the appearance of a set of query results by resizing its
columns and rows.
1. Using the mouse select the black dividing line between two columns or

two rows.
2. Drag the divider line from side to side or up and down to resize the

column or row.

Note: If you save the query after resizing its rows or columns, that query
is always displayed using the new formatting.

Auto fitting columns and rows
You can automatically size columns and rows to fit the data they contain.

Using the mouse, select an entire column and double-click on the black
dividing line between it and the adjacent column. The column is automatically
resized to fit its data.
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Note: If you save the query after resizing its rows or columns, that query is
always displayed using the new formatting.

Sorting query results
Once you have run a query, you can sort the results alphabetically by column.

From the Results view of a query, select a column and click the Sort
Ascending button on the toolbar.

The query results are sorted in ascending order.

-or-

From the Results view of a query, select a column and click the Sort
Descending button.

The query results are sorted in descending order.

Working with Fonts

You can change the font used to display queries and query results. The choice
of fonts varies according to what has been installed on your computer. For
more information on adding fonts, refer to your operating system’s help
facility.

Note: If you save the query after selecting a new query display or query
results display font, that query is always displayed using the new font.

Selecting the query display font
1. From the SQL view, click Set Font from theQuery menu. The Font dialog

box opens.
2. Select the font for displaying the text of the query and click OK. The

query reappears in the new font.

Note: Click Set As Default to use the selected font as the default font for
all new queries.

Selecting the query results display font
1. From the Results view, click Set Font from the Query menu. The Font

dialog box opens.
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2. Select the font for displaying the results of the query and click OK. The
query results reappear in the new font.

Note: Click Set As Default to use the selected font as the default font for
all query results.

Multiple queries

You can have more than one query document open at the same time. You can
also run more than one query at a time. You can use this feature to generate
multiple reports, or to cut and paste SQL text from one query to another.

Displaying multiple queries simultaneously
1. Open at least two query documents.
2. From the Window menu, select one of the following commands:

Command Result

Cascade Displays queries in a staggered series.

Tile Horizontal Displays query windows stacked vertically.

Tile Vertical Displays query windows stacked side by side.

The query windows are arranged according to the option you select.

Drawing Queries

Use the Draw Query command to create new SQL query documents. You
specify one or more table names and the type of SQL statement that you
want, and QMF for Windows automatically creates an SQL statement that
references the names and data types of the columns in the table.
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Creating new SQL queries
1. From the File menu, click Draw Query. The Draw Query dialog box

opens.

2. Select the type of query that you want to create:

Query type Result

Select Retrieve rows from one or more tables.

Update Change the information in a table.

Insert Add new rows to a table.

3. Enter the owner and name of the table to be queried.

Note: You can use patterns to select table names from a list of matching
tables.

v Use the percent character (%) to match a string of any length containing
any characters. For example, to list all tables with a name beginning
with the letter A, enter A%.

v Use the underscore character (_) to match a single character. For
example, to list all tables with an owner that has the letter A in the
second position, enter _A%.

After you enter a pattern, click Add from List and select a table from the
resulting list.

4. Enter a unique identifier for the table.
5. Click Add. The table is added to the query.

Chapter 2. Working with SQL queries 11



6. When you have added the table or tables that you want to query, click
OK. An SQL query for the selected tables is created and displayed.

Substitution Variables in SQL Queries

With substitution variables, you can use the same query to retrieve different
information by supplying different values each time you run the query. To
retrieve a different set of data, you do not need to rewrite the query. Rather,
you just supply different values for the substitution variables in the query
when you run it.

A substitution variable is text that you include in a query. It must begin with
an ampersand character (&), and can contain up to 18 characters, which can
be alphabetic, numeric, or one of the following special characters: [ ! $ ∼ { } ?
@ # % \ or _. For example, the following values are valid substitution
variables:
&VARIABLE1
&DEPARTMENT_NUMBER

A substitution variable can appear anywhere in a query, and its value can be
anything that you might write in a query (except a comment). For example,
you can use a substitution variable in place of a column name, search
condition, subquery, or any specific value.

Running SQL queries with substitution variables
1. Open a new query document and enter this SQL statement:

SELECT * FROM Q.STAFF WHERE DEPT >= &MIN_DEPT

2. Run the query. The Enter Substitution Variable Values dialog box opens.

3. In the Value field enter a value of 50 and click OK. The query runs and
displays the query results.
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Try experimenting with substitution variables by replacing values in the
SELECT and FROM clauses. See what results your queries return with
different inputs.

Saving SQL Queries

You can save queries on your PC, on a file server, or at a database server.

Saving SQL queries to files
1. From an open query, click the Save button on the toolbar.

If the query has been saved before, it is saved again. If the query has not
been previously saved, the Save As dialog box opens.

2. Enter the name of the file where you want the query stored and click OK.
The query is saved.

Opening saved SQL query files
1. Click the Open button on the toolbar.

The Open dialog box opens.
2. Select the file that you want to open and click OK. The selected query

opens in a new query document.

Saving SQL queries at the database server
Queries saved at the server can be made accessible to other users. If you want
to share your queries with other users, save them at the database server.
1.

From an open query, click the Save at Server button on the toolbar.
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The Save Query dialog box opens.

2. Enter an owner, a name, select whether or not to share the saved query
with other users, and click OK. The query is saved at the server.
If a query with this name already exists, you are prompted to overwrite
the previously existing query.

Opening saved SQL queries at the database server
You can open queries that have been saved at the database server.
1.

Click the Open From Server button on the toolbar.

The Open From Server dialog box opens.

2. Enter a server, owner, and name and click OK. The SQL query opens.

Printing SQL Queries and Results

You can print your SQL statement and query results.

Previewing a query
1. Open a query and activate the SQL view. The SQL statement appears.
2. From the File menu, click Page Setup. The Page Setup dialog box opens.
3. Make any changes you want to the layout of the page and click OK.
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4. Click the Print Preview button on the toolbar:

A preview of the printed query appears.

Previewing query results
1. Open and run a query. The query results appear.
2. From the File menu, click Page Setup. The Page Setup Dialog box opens.
3. Make any changes you want to the layout of the page and click OK.
4. Click the Print Preview button on the toolbar:

A preview of the printed query results appears.

Printing SQL queries
1. Open a query and activate the SQL view. The SQL statement appears.
2. From the File menu, click Page Setup. The Page Setup Dialog box opens.
3. Make any changes you that want to the layout of the page and click OK.
4. Click the Print button on the toolbar:

The query is printed.

Printing query results
1. Open a query and activate the Results view. The query results appear.
2. From the File menu, click Page Setup. The Page Setup Dialog box

appears.
3. Make any changes that you want to the layout of the page and click OK.
4. Click the Print button on the toolbar.

The query results are printed.
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Chapter 3. Building Prompted Queries

Prompted queries are an easy way for you to create a query by selecting
options from menus and lists. Once you have created a prompted query, you
can save it, or convert it to an SQL query.

Building simple queries

You can easily build simple queries using the prompted query interface.

Opening new prompted queries
v From the File menu, click New Prompted Query. A new Prompted Query

document appears.

Prompted query action buttons
Edit prompted queries using the query action buttons. A set of buttons
appears above the section that it controls.

Prompted query action
button

Appearance Result

Add Click to add an item to the prompted query.

Edit Click to edit the highlighted item in the query.

Delete Click to delete the selected item.
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Move up and Move
down

Click to move the selected item up and down in the
prompted query.

Adding tables to prompted queries
1. In the Tables section of the Prompted Query document, click the Add

button.

The Tables dialog box opens.

2.

Type the owner and name of the table that you want to add and click
Add. The table is added to the query.

Note: You can use patterns to select objects from a list of matching objects.
v Use the percent character (%) to match a string of any length containing

any characters. For example, to list all tables with a name beginning
with the letter A, enter A%.

v Use the underscore character (_) to match a single character. For
example, to list all tables with an owner that has the letter A in the
second position, enter _A%.

After you enter a pattern, click Add From List and select a table from the
resulting list.

3. Add any additional table conditions to the query and click Close. The
prompted query document appears with the new tables listed.

Running prompted queries
You run a prompted query the same way that you run an SQL query.Click the
Run Query button on the toolbar.

The prompted query runs.
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Building Complex Queries

You can also build more complex queries using the prompted query interface.

Adding columns to prompted queries
1. In the Column section of the Prompted Query document, click the Add

button.

The Columns dialog box appears.

2. Select the column you want to add and click Add. The column is added to
the prompted query.

3. Add any additional columns to the query and click Close. The Prompted
Query document appears with the new columns listed.

Note: You can apply a summary function to the column by selecting one in
the Function field. Available summary functions include: AVERAGE,
COUNT, MAXIMUM, MINIMUM, and SUM.

Note: You can rename a column in the query by typing a new column name
in the New column name field.

Using sort conditions
Sort conditions are used to specify the way you want to sort the rows in the
query. Rows can be sorted in ascending (A-Z) or descending (Z-A) order.
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If you sort your rows by more than one column, the first column is ordered
first, the second column is ordered within the order of the first column, and
so on.

Adding sort conditions
1. In the Sort conditions section of the Prompted Query document, click the

Add button.

The Sort Conditions dialog box displays.

2. Select the column you want to sort by, the direction in which to sort, and
click Add. The sort condition is added to the prompted query.

3. Add any additional sort conditions to the query and click Close. The
Prompted Query document appears with the new sort conditions listed.

Using row conditions
Many times you want to view only certain rows in a table. To select specific
rows to view, add row conditions. If you don’t use row conditions, all the
rows in the table are displayed.

The following row conditions are available:
v Equal to
v Less than
v Less than or equal to
v Greater than
v Greater than or equal to
v Between
v Starting with
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v Ending with
v Containing
v NULL

Row conditions are controlled by the following operators:
v Is
v Is Not

Adding row conditions
1. In the Row conditions section of the Prompted Query document, click the

Add button.

The Row Conditions dialog box displays.

2. Select the parts of the conditional statement and click Add.

Part of the row condition Function

Left side Select the column you want to examine.

Operator Determine the relationship between the left and right hand
sides of the row.

Right side Enter the condition for which you want to check.

The row condition is added to the prompted query.
3. Add any additional row conditions to the query and click Close. The

Prompted Query document appears with the new row conditions listed.

Using multiple tables in prompted queries
You can include information from more than one table in a prompted query.

Chapter 3. Building Prompted Queries 21



You must relate the two tables, specifying one or more join conditions in each.
Only rows from the tables where join columns are equal are included in the
results. The data type of each column in a join condition must match. Once
you have specified a relationship between two columns, QMF for Windows
remembers the relationship, and suggests it in future queries, making the
creation of subsequent queries simpler and more efficient.

Creating prompted query join conditions
1. In the Tables section of the Prompted Query Window click the Addbutton

to add at least two tables. If you have never joined the tables before, the
Join Tables dialog box appears. If you have, QMF for Windows suggests
the join condition that you used previously.

2. Select a column with the same data type from each table and click Add.
The new join condition appears in the prompted query.

Prompted queries and SQL

You can use the prompted query interface to learn SQL

Viewing SQL for prompted queries
v From the prompted query view, click the View SQL button on the toolbar.

The equivalent SQL statement for the prompted query appears. You cannot
modify the SQL statement from this view.

Converting prompted queries to SQL
You can convert a prompted query to a new SQL query document. The new
SQL query can be modified, saved, printed, etc.
v From the Query menu, click Convert to SQL. The query is converted into a

new SQL query document.
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Using Substitution Variables in Prompted Queries

Substitution variables can be used in a prompted query in the same way as in
an SQL query. See "“Substitution Variables in SQL Queries” on
page 12“Substitution Variables in SQL Queries” on page -28".

For example, substitution variables can be used in:
v a row condition

DEPT Is Greater Than Or Equal To &MinDept

v a column specification
&InputNum

Saving Prompted Queries

Prompted queries can be saved in files on your PC, on a file server, or at a
database server.

Saving prompted queries to files
1. From an open prompted query, click the Save button on the toolbar.

Note: IIf the query has been saved before, it is saved again. If the query
has not been previously saved, the Save As dialog box opens.

2. Enter the name of the file where you want the prompted query stored and
click OK. The query is saved.

Opening saved prompted query files
1. Click the Open button on the toolbar.

The Open dialog box opens.
2. Select the file you want to open and click OK. The selected prompted

query opens in a new query document.

Saving prompted queries at the database server
1. From an open prompted query, click the Save at Server button on the

toolbar.
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The Save Query dialog box opens.

2. Enter an owner, a name, select whether or not to share the saved query
with other users, and click OK. The query is saved at the server.
If a query with this name already exists, you are prompted to overwrite
the previously existing query.

Opening saved prompted queries at the database server
You can open prompted queries that have been saved at the database server.
1.

Click the Open From Server button on the toolbar.

The Open From Server dialog box opens.

2. Enter a server, owner, and name and click OK. The prompted query
opens.

Printing Prompted Queries

You can print your prompted query. You can also print the SQL text or the
results of a prompted query. See “Printing SQL Queries and Results” on
page 14Printing SQL Queries and Results on page 2-31

Previewing prompted queries
You can preview the results or text of a prompted query before you print it.
1. Open a query and activate the prompted view. The query appears.
2. From the File menu, click Page Setup. The Page Setup dialog box opens.
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3. Make any changes you want to the layout of the page and click OK.
4. Click the Print Preview button on the toolbar:

A preview of the printed query appears.
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Chapter 4. Building Reports

Reports are created by combining data from a query with formatting from a
form.

Forms

Forms are used to create, display, and print reports.

Understanding Forms
Forms are composed of a number of components. These components can all
be edited in a form document.

Main The primary components of a form, including headings, footings, and
breaks.

Breaks
Characteristics, content, and placement of up to six subtotal lines in a
report.

Calculations
Report calculation expressions.

Note: You must have IBM’s ObjectREXX installed on your machine to
use form calculations.

Columns
Appearance and formatting of columns in the report. Definable
characteristics include column order, format, usage, indentation, and
width.

Conditions
Conditional formatting constraints. For example, you can set the form
to not display rows that do not meet certain characteristics.

Note: Although this form component can be edited and saved, form
conditions are not supported when producing a report in
Windows.

Details
Report detail headings and body text. This is where you can combine
or replace tabular data with free-form text to create form letters or
address labels.
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Final Content and placement of your report’s final text. For example, you
can choose to include final text and summary data at the end of the
report.

HTML
Content and placement of HTML tags and formatting in HTML
reports.

Options
Miscellaneous appearance options for your report.

Page Content and placement of the page heading and footing on your
report.

Producing a report using a form
Reports are created by combining query results with the formatting options
contained in a form. You can produce multiple reports from a single set of
query results by repeating this process.
1. From a query results view, click theDisplay Report button.

The Select Form dialog box appears.

2. Depending on the type of form you select in the Select From dialog box,
you are asked to provide additional information. Specify the file location
or owner and name, or document title, as appropriate, and click OK. The
report is generated using the selected form and current query results.

Editing a form
The Form window provides many options for editing and formatting forms.

From an open form, display the Form menu. The Form menu lists all your
options for editing and formatting your form. You can also edit any of these
components by clicking the corresponding button on the toolbar.

Creating a form

These steps all include sample data from the table Q.STAFF. Try
experimenting with different settings to create your own custom forms.
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Step 1: Create a form
1. Run the following SQL query to retrieve the data to display in the report:

SELECT * FROM Q.STAFF ORDER BY DEPT, NAME

The query results appear.
2. Click the Display Report button on the toolbar. The Select Form dialog

box appears.
3. Specify that you want to use the default form and click OK. QMF for

Windows displays the default report. To make changes to the default
format, click one of the form component buttons on the toolbar. A button
for each form component is displayed on the form toolbar.

Step 2: Change the Column Order
We want NAME to be the first column in the report and ID to be the second.
The order of the columns is specified in the Columns component of the form.
1. Click Columns on the Form menu to display the Form Columns dialog

box.
2. Change the sequence of a column by typing over the existing sequence

value. To make NAME the first column in the report, change its sequence
number (the column in the list labeled Seq) to 1.

3. To make ID the second column in the report, change its sequence number
to 2 and click OK. QMF for Windows displays the report with the new
column order in the Form window.

Step 3: Change the Column Headings
We want the first column heading to be EMPLOYEE and the second to be
COMMISSION. Column heading text is specified in the Columns component
of the form.
1. Click Columns on the Form menu to display the Form Columns dialog

box.
2. Change the column heading by typing over the existing column heading

text. Change the first column heading to EMPLOYEE, and the last column
heading to COMMISSION and click OK. QMF for Windows displays the
report with the new column headings in the Form window.

Step 4: Change the Column Format
We want the SALARY column to be displayed with the appropriate currency
symbol. The format of a column is determined by its edit code, which is
specified in the Columns component of the form.
1. Click Columns on the Form menu to display the Form Columns dialog

box.
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2. Change the SALARY column edit code to D2 by typing over the existing
edit code and click OK. QMF for Windows displays the report with the
SALARY column using the appropriate currency symbol in the Form
window.

Step 5: Add Summary Information
We want to divide the report into separate sections for each department. In
addition, we want to see the total SALARY and COMMISSION for each
department at the end of each section. To do this, we need to specify how we
want each column in the report to be used. The usage of a column is
determined by its usage code and is specified in the Columns component of
the form.
1. Click Columns on the Form menu to display the Form Columns dialog

box.
2. To divide the report into sections based on DEPT, change the usage code

of DEPT to BREAK1. Usage codes beginning with the word BREAK
produce a section break for the specified column. The number that follows
the word BREAK determines the break level; up to six break levels are
supported in a report.

3. To specify that we want to include a total SALARY and COMMISSION for
each DEPT, change the usage code of SALARY and COMMISSION to
SUM.

4. The report will be easier to understand if we also include descriptive
information at the end of each section break. To do this, click Breaks on
the Form menu.

5. You specify break footing text on the Form Breaks dialog box. Set the first
break footing line to Department Total and click OK. QMF for Windows
displays the Form window.

Step 6: Add Page Headers and Footers
We want to add a page heading and footing to our report. Page headings and
footings are specified in the Page component of the form.
1. Click Page on the Form menu to display the Form Page dialog box
2. The top portion of this dialog is used to specify the page heading. Set the

first line of the page heading to Department Report and the second line to
Total Salary and Commissions. Choose how you want the heading to be
aligned.

3. The bottom portion of this dialog is used to specify the page footing. Set
the first line of the page footing to End Of Page. Choose how you want
the footing to be aligned and click OK. QMF for Windows displays the
Form window.
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Saving Forms

You can save forms on your PC, on a file server, or at a database server.

Saving a form to a file
1. From an open form, click the Save button.
2. If the form has been saved before, select Save. If the form has not been

previously saved, the Save As dialog box opens.
3. Enter the name of the file where you want the form stored, and click OK.

The form is saved.

Opening saved form files
1. Click the Open button on the toolbar.

The Open dialog box appears.
2. Select the file that you want to open and click OK. The selected form

opens in a new form document.

Saving forms at the database server
Forms saved at the server can be made accessible to other users. If you want
to share your forms with other users, save them at the database server.
1.

From an open form, click the Save at Server button on the toolbar.

The Save Form dialog box opens.

2. Enter an owner, a name, select whether or not to share the saved form
with other users, and click OK. The form is saved at the server.
If a form with this name already exists, you are prompted to overwrite the
previously existing form.

Chapter 4. Building Reports 31



Opening saved forms at the database server
You can open forms that have been saved at the database server.
1.

Click the Open From Server button on the toolbar.

The Open From Server dialog box opens.

2. Enter a server, owner, and name and click OK. The form opens.

Printing Reports

You can produce printed reports.
1. Open a form and click Page Setup.
2. Make any changes that you want to the layout of the page and click OK.
3. ClickPrint Report on the File menu.

The report is printed.

Exporting Reports

You can export a report to a file.
1. Open a form and click Page Setup.
2. Make any changes that you want to the layout of the page and click OK.
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3. ClickExport Report on the File menu. The Export Report dialog box
opens.

4. Enter the name of the file where you want the report stored and click OK.
The report is exported.
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Chapter 5. Working with procedures

Linear procedures enable you to run queries, generate reports, edit data, and
perform other functions by executing a single command. For a complete
listing of all the procedure commands supported by QMF for Windows, refer
to the online help facility.

QMF for Windows does not currently support procedures with logic (REXX
procedures).

Running procedures

Procedures are used to execute multiple functions with one command.

Creating a new procedure
From the File menu, select New Procedure.

A new procedure document opens.

Running a procedure at a database server
1. Open a new procedure document and type in a set of commands, or open

an existing procedure from a file or the database server.
2. Click the Run Procedure button on the toolbar.

The procedure runs.

Saving procedures

You can save procedures on your PC, on a file server, or at a database server.

Saving procedures to files
1. From an open procedure, click the Save button on the toolbar.

If the procedure has been saved before, the procedure is saved. If the
procedure has not been previously saved, the Save As dialog box opens.

2. Enter the name of the file where you want the procedure stored and click
OK. The procedure is saved.
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Opening a saved procedure file
1. Click the Open button on the toolbar.

The Open dialog box appears.
2. Select the file you want to open and click OK. The selected procedure

opens in a new procedure document.

Saving a procedure to the database server
1.

From an open procedure, click the Save at Server button on the toolbar.

The Save Procedure dialog box opens.

2. Enter an owner, a name, select whether or not to share the saved
procedure with other users, and click OK. The procedure is saved at the
server.
If a procedure with this name already exists, you are prompted to
overwrite the previously existing procedure.

Opening saved procedures at the database server
You can open procedures that have been saved at the database server.
1.

Click the Open From Server button on the toolbar.
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The Open From Server dialog box opens.

2. Enter a server, owner, and name and click OK. The procedure opens.

Printing procedures

You can print the text of a procedure.

Previewing a procedure
1. Open a procedure. The procedure commands appear.
2. From the File menu, click Page Setup. The Page Setup Dialog box opens.
3. Make any changes you want to the layout of the page and click OK.
4. Click the Print Previewbutton on the toolbar:

A preview of the printed procedure appears.

Printing a procedure
1. Open a procedure. The procedure commands appear.
2. From the File menu, click Page Setup. The Page Setup Dialog box opens.
3. Make any changes you that want to the layout of the page and click OK.
4. Click the Print button on the toolbar:

The procedure is printed.
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Chapter 6. Working with Lists

Lists provide you with an easy way to view collections of QMF objects.

Objects

QMF for Windows recognizes four types of objects: queries, forms,
procedures, and tables. You can use the List window to view the objects based
on the object name, owner, and type.

Listing objects
1. On the File menu, click New List .

The List window appears.

2. Specify an owner and a name.

Note: You can use patterns to select objects from a list of matching objects.
v Use the percent character (%) to match a string of any length containing

any characters. For example, to list all tables with a name beginning
with the letter A, you enter A%.

v Use the underscore character (_) to match a single character. For
example, to list all tables with an owner that has the letter A in the
second position, enter _A%.

© Copyright IBM Corp. 1997, 2000 39



3. Select the type of object for which you are searching.
4. Click Refresh List. A list of objects saved at the database server and

meeting your requirements is displayed.

List window commands

Right clicking on an object in the List window displays a list of commands
identical to those in the List menu.

Display object
v Opens the selected object for viewing.

Available for queries, forms, procedures, tables.

Run object
v Runs the selected object.

Available for queries and procedures.

Draw object
v Creates a query based on the selected table. You can choose to draw an

SQL SELECT query, an SQL UPDATE query, an SQL INSERT query, or a
prompted query.
Available for tables.

Edit object
v Opens the selected object for editing.

Available for tables.

Properties
v Displays the properties of the selected object, including comments,

attributes, and historical usage information.
Available for queries, forms, procedures, tables.

Creating lists

You can create lists to serve as collections of objects. For example, you could
create a list of all inventory related queries, forms, procedures and tables to
keep your work in one place. Once created, you can remove unrelated objects
from the list and save the list for future use.

Removing objects from lists
You can remove unrelated objects from lists.
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From an open list, click the Remove button on the toolbar.

The object is removed from the list, but is not deleted.

Saving lists to files
1. From an open list, click the Save button on the toolbar.

If the list has been saved before, the list is saved. If the list has not been
previously saved, the Save As dialog box opens.

2. Enter the name of the file where you want the list stored and click OK.
The list is saved.

Opening saved list files
1. Click the Open button on the toolbar.

The Open dialog box opens.
2. Select the file that you want to open and click OK. The selected list opens

in a list document.
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Chapter 7. Working with static queries

A static query is an SQL query that has been previously passed to a database
server and bound into a package. When a static query is run, the database
server uses the SQL text bound in the package, rather than the SQL text
currently appearing in the query window. Static queries are more resource
efficient than dynamic queries, but static queries cannot be edited.

Static queries

Static queries are created from previously existing SQL and prompted queries.

Creating static queries
1. From the Query menu, click Bind Static Package. The Bind Static Package

dialog box opens.

2. Select the Package tab, enter a collection ID and package name and change
any other desired options.

3. If the query contains any substitution variables, select the Variables tab.
Replace any substitution variables with host variables.

4. Click OK. The static query is bound.
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Note: After you bind a query, you must also save that query either to a
file or to the database server.

Replacing substitution variables with host variables
When you bind a package, you must specify a host variable to use in place of
each substitution variable in the SQL text. However, a substitution variable
cannot always be directly replaced by a host variable. Substitution variables
provide direct text substitution in the query text before the text is sent to the
database server. Host variables are sent as part of the query to the database
server. Refer to the documentation for your database server for rules on where
and how host variables can be used in queries.

After you specify a relationship between a substitution variable and a host
variable, QMF for Windows remembers the relationship, and suggests it in
future queries, making binding packages simpler.

The valid data types for host variables are:
v CHAR(n)
v VARCHAR(n)
v INTEGER
v SMALLINT
v FLOAT
v DECIMAL(p,s)
v DATE
v TIME
v TIMESTAMP
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1. From the Bind Static Package dialog box, select the Input Variables tab.

2. Enter the type of variable for each host variable and click OK. The
substitution variables are converted to host variables.

Running a static query
You run static queries as you would any other queries. See “SQL Queries” on
page 7“SQL Queries” on page -21.
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Chapter 8. Working with the Table Editor

Use the table editor to search for, add, edit, or delete data stored in your
tables without having to write SQL statements.

Table Editor

The table editor gives you flexibility in editing and searching your data.

Searching for rows using the table editor
1. From the File menu, click Table Editor. The Table Editor dialog box opens.

2. Specify a table.

Note: You can use patterns to select table names from a list of matching
tables.

v Use the percent character (%) to match a string of any length containing
any characters. For example, to list all tables with a name beginning
with the letter A, you enter A%.

v Use the underscore character (_) to match a single character. For
example, to list all tables with an owner that has the letter A in the
second position, enter _A%.

Once you have entered a pattern, click List Tables and select a table from
the resulting list.

3. Select a Save Mode.
v Immediate - The table will be updated at the database server

immediately after each change.
v End - The table will be updated at the database server after you finish

entering all changes. Other users will not be able to make changes to
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the table while you are making your changes.

4. Click Edit. The Edit table dialog box opens.
5. Enter the values for which you want to search in the Value column, or

type search criteria in the Additional search criteria field to specify more
complex search conditions. You can enter any valid SQL predicate in the
Additional search criteria field.

6. Click Start Search. The first matching row is displayed in the Value
column.

Adding a row
1. In the Edit Table dialog box, enter the information for the new record.
2. Click Insert Row. The new row is added to the table.
3. Click OK. Your changes are saved.

Changing a row
1. From the Edit Table dialog box, search for the row you want to change.
2. Click Next Row until the row you want to change is displayed.
3. Edit the data in the Value column and click Update Row. The row is

updated.
4. Click OK. Your changes are saved.

Deleting a row
1. From the Edit Table dialog box, search for the row that you want to delete.
2. Click Next Row until the row you want to delete is displayed.
3. Click Delete Row. The row is deleted.
4. Click OK. Your changes are saved.
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Editing tables from the query results view

You can edit tables directly from the query results view.

Deleting a row from the query results view
You can delete individual rows from tables in the query results view.
v From the query results view, select a row and click Delete from the Edit

menu. The row is deleted.

Updating columns from the query results view
You can update the contents of individual columns in the query results view.
v From the query results view, double click on a cell, enter a new value, and

press Enter. The table is updated.
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Chapter 9. Distributing Data

You can export your data to other databases and applications.

Exporting Data

You can export data from QMF for Windows into other applications in the
following ways:
v Export the data into a Text, CSV, IXF, or HTML file
v Save query results to a table
v Add query results directly into a Microsoft Excel or Lotus 1-2-3 spreadsheet

Exporting data to files
1. While viewing query results, click Export Data on the File menu. The

Export Data dialog box appears.

2. Select the desired Output File Type and click the Options button.
Depending on the type of output file you select, either the Export
Text⁄DEL Options dialog box, the Export HTML Options dialog box, the
Export IXF Options dialog box, or the Export CSV Options dialog box
appears.
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v You can produce a text file, with a .TXT extension. This is a standard
ASCII file with optional string and column delimiters (as specified in
the Export Text⁄DEL Options dialog box).

v You can produce an HTML file, with a .HTM extension file. This is an
HTML file that can be viewed by any web browser. All of the HTML
tags are automatically generated in the file; it is ready to be published
on your Internet or intranet web site. The options you choose on the
Export HTML Options dialog box control the appearance of the
exported data.

v You can produce a .IXF file. An IXF export preserves all database
information, including column headings and data types. It is typically
used to transfer information from one database to another.

v You can produce a .CSV file. A CSV export is very similar to a text
export, using a comma as the column delimiter. This format is most
commonly used by spreadsheet applications.

3. Select the options for the selected type of export file and click OK. The
Options dialog box closes.

4. Click OK on the Export Data dialog box. The data is exported.

Importing data
You can import data that has been saved in a IXF file. Once data is imported
into a query window, it can be saved to a database server, exported to a new
file, or used for reports. PC⁄IXF and character mode System⁄370 IXF files are
supported.
1. From the File menu, click Import Data. The Import Data dialog box

opens.

2. Select the file you want to import and click OK. The imported data is
displayed in a new query window.

Saving data to a database server
Imported query results can be saved to a database table.
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1. While viewing imported query results, click Save Data on the File menu.
The Save Data dialog box appears.

2. Select a database server, enter a table owner and name, choose any other
desired options and click OK. The data is saved.

Using the Microsoft Excel Add-In

The 16-bit version of QMF for Windows includes an add-in for Microsoft
Excel 5.0c and the 32-bit version includes an add-in for Microsoft Excel 7.0 or
later. These add-ins enable you to run QMF for Windows from Excel and
return query results directly into a spreadsheet. The appropriate add-in is
automatically installed if you choose the "Typical" installation option, or if you
choose the "Custom" installation option and select the Microsoft Excel Add-In
option.
1. Click the QMF for Windows button on the Excel toolbar.

QMF for Windows activates.
2. From QMF for Windows, select and run a query. The query results appear.
3. Select the data you want to return to Excel.
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4. From the File menu, click Return data to Microsoft Excel. Excel activates
and displays the QMF for Windows Add-In dialog box.

5. Enter the destination range for the data and click OK. The data is added
to the spreadsheet.

Using the Lotus 1-2-3 Add-In

The 16-bit version of QMF for Windows includes an add-in for Lotus 1-2-3
that enables you to run QMF for Windows from 1-2-3 and return query results
directly into a spreadsheet. This add-in is installed if you choose the "Typical"
installation option, or if you choose the "Custom" installation option and
select the Lotus 1-2-3 Add-In option.

Note: There is no 32-bit add-in for Lotus 1-2-3.
1. Click the QMF for Windows button on the 1-2-3 toolbar. QMF for

Windows activates.
2. From QMF for Windows, select and run a query. The query results

appear.
3. Select the data you want to return to 1-2-3.
4. From the File menu, click Return data to Lotus 1-2-3. The Data

Option dialog box appears.
5. 1-2-3 activates and displays the QMF for Windows Add-In dialog

box.
6. Enter the destination range for the data and click OK. The data is

added to the spreadsheet.

Using Sample Applications

Several sample applications and integration solutions are available for QMF
for Windows. Visit the IBM web site at http:⁄⁄www.ibm.com⁄qmf⁄ to find out
more.

Building an Application Using the QMF for Windows API

You can build your own applications using QMF for Windows. Refer to the
online API help for a complete listing of all the API functions and their
effects. Visit the IBM web site at http:⁄⁄www.ibm.com⁄qmf⁄ to see various
programming examples.
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Appendix. Notices

This information was developed for products and services offered in the
U.S.A. IBM may not offer the products, services, or features discussed in this
document in other countries. Consult your local IBM representative for
information on the products and services currently available in your area. Any
reference to an IBM product, program, or service is not intended to state or
imply that only that IBM product, program, or service may be used. Any
functionally equivalent product, program, or service that does not infringe
any IBM intellectual property right may be used instead. However, it is the
user’s responsibility to evaluate and verify the operation of any non-IBM
product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give
you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10594-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the
IBM Intellectual Property Department in your country or send inquiries, in
writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any
other country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY
OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow
disclaimer of express or implied warranties in certain transactions, therefore,
this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will
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be incorporated in new editions of the publication. IBM may make
improvements and/or changes in the product(s) and/or the program(s)
described in this publication at any time without notice.

Any references in this publication to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for
this IBM product and use of those Web sites is as your own risk.

Licensees of this program who wish to have information about it for the
purpose of enabling: (i) the exchange of information between independently
created programs and other programs (including this one) and (ii) the mutual
use of the information which has been exchanged, should contact:

IBM Corporation
J74/G4
555 Bailey Avenue
P.O. Box 49023
San Jose, CA 95161-9023
U.S.A.

Such information may be available, subject to appropriate terms and
conditions, including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer
Agreement, IBM International Program License Agreement, or any equivalent
agreement between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments
may vary significantly. Some measurements may have been made on
development-level systems and there is no guarantee that these measurements
will be the same on generally available systems. Furthermore, some
measurement may have been estimated through extrapolation. Actual results
may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available
sources. IBM has not tested those products and cannot confirm the accuracy
of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be
addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change
or withdrawal without notice, and represent goals and objectives only.
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All IBM prices shown are IBM’s suggested retail prices, are current and are
subject to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is
subject to change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include
the names of individuals, companies, brands, and products. All of these
names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language,
which illustrates programming techniques on various operating platforms.
You may copy, modify, and distribute these sample programs in any form
without payment to IBM, for the purposes of developing, using, marketing or
distributing application programs conforming to the application programming
interface for the operating platform for which the sample programs are
written. These examples have not been thoroughly tested under all conditions.
IBM, therefore, cannot guarantee or imply reliability, serviceability, or function
of these programs.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks

The following terms are trademarks of the IBM Corporation in the United
States or other countries or both:

Advanced Peer-to-Peer
Networking

AIX
AIX/6000
CICS
CICS/MVS
CICS/VSE
DATABASE 2
DB2
Distributed Relational

Database Architecture
DRDA
DXT

GDDM
IBM
MVS/ESA
MVS/XA
OfficeVision/VM
OS/2
PL/I
PROFS
QMF
SQL/DS
Virtual Machine/Enterprise

Systems Architecture
VM/XA
VSE/ESA
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Other company, product, and service names, which may be denoted by a
double asterisk (**), may be trademarks or service marks of others.
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adding a row
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creating 54

B
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C
calculations
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changing a row

table editor 48
changing passwords 3
columns

adding to prompted queries 19
forms 27
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complex queries
building 19

conditions
forms 27

containing (row condition) 21
creating

static queries 43

D
database

security 2
database server

exporting data to 52
details

forms 27
display objects 40
draw object 40

draw queries
creating 11

E
edit object 40
ending with 21
equal to (row condition) 20
Excel

add-in 53
exporting

reports 32
exporting data

to a database server 52
to files 51
to other tables 52

F
files

exporting data to 51
final

forms 28
fonts

query display 9
results display 9

form
main 27

forms
breaks 27
calculations 27
columns 27
conditions 27
details 27
final 28
HTML 28
opening a saved file 31, 36
options 28
page 28
producing a report 28
saving to files 31, 35
saving to the database

server 31, 36

G
governing 4
greater than (row condition) 20
greater than or equal to (row

condition) 20

H
host variables

using in static queries 43
HTML

forms 28

I
Is (row condition operator) 21
Is Not (row condition operator) 21

J
join conditions

creating in prompted queries 22

L
less than (row condition) 20
less than or equal to (row

condition) 20
listing

objects 39
lists

opening saved files 41
logging on 2
Lotus 1-2-3

add-in 54

M
main

forms 27
multiple queries

displaying simultaneously 10
multiple query documents 10
multiple tables

in prompted queries 21

N
new

draw queries 11
prompted queries 17
SQL query 7
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null (row condition) 21

O
objects

listing 39
opening

procedures at the database 36
prompted queries at the database

server 24
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opening (continued)
prompted query files 23
saved forms at the database

server 32
saved SQL files 13
SQL queries at the database

server 14
options

forms 28

P
page

forms 28
passwords

correcting 3
previewing

printed procedure 37
printed queries 14, 15
reports 28

print preview
prompted queries 24

printing
procedure 37
query results 15
reports 32
SQL queries 15

procedure
printing 37

prompted queries
adding columns 19
adding tables 18
converting to SQL 22
creating 17
creating join conditions 22
opening saved files 23
running 18
saving as files 23
saving to the database server 23
using multiple tables 21
using SQL in 22
using substitution variables 23
viewing SQL 22

prompted query
action buttons 17

Q
queries

building complex 19
query results

printing 15

R
reports

exporting 32
previewing 28
printing 32

reports (continued)
producing a report using

forms 28
resizing columns 8, 9
resizing columns and rows 8
results

printing 15
results view 7
row condition operator

Is 21
Is Not 21

row conditions
adding 21
between 20
containing 21
ending with 21
equal to 20
greater than 20
greater than or equal to 20
less than 20
less than or equal to 20
null 21
starting with 20
using 20

rows
selecting 8, 9

run object 40
running

prompted queries 18
SQL query at a database

server 7
static queries 45

S
sample applications 54
saving

forms to files 31, 35
forms to the database server 31,

36
prompted queries as files 23
prompted queries to the database

server 23
SQL queries to files 13
SQL queries to the database

server 13
searching

table editor 47
selecting

columns 8, 9
rows 8, 9

server
setting 1

sort conditions
adding 20
using 19

SQL
using in prompted queries 22

SQL queries
opening a new document 7
opening saved files 13
print preview 14, 15
printing 15
running at the database server 7
saving to files 13
saving to the database server 13

starting with (row condition) 20
static queries

creating 43
running 45
using substitution variables 43

substitution variables
in SQL queries 12
replacing with host variables 43
running SQL queries with 12
using in prompted queries 23
using in static queries 43

T
table editor 47

adding a row 48
changing a row 48
searching for rows 47

tables
adding to prompted queries 18
exporting data to 52

toolbar
adding buttons 5
customizing 5
moving buttons 6
removing buttons 6

V
viewing

results 7
SQL 7
SQL in prompted queries 22
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Readers’ Comments — We’d Like to Hear from You

Query Management Facility
Getting Started with QMF for Windows

Publication No. SC26-9582-02

Overall, how satisfied are you with the information in this book?

Very Satisfied Satisfied Neutral Dissatisfied Very
Dissatisfied

Overall satisfaction h h h h h

How satisfied are you that the information in this book is:

Very Satisfied Satisfied Neutral Dissatisfied Very
Dissatisfied

Accurate h h h h h

Complete h h h h h

Easy to find h h h h h

Easy to understand h h h h h

Well organized h h h h h

Applicable to your tasks h h h h h

Please tell us how we can improve this book:

Thank you for your responses. May we contact you? h Yes h No

When you send comments to IBM, you grant IBM a nonexclusive right to use or distribute your comments in any
way it believes appropriate without incurring any obligation to you.

Name Address

Company or Organization

Phone No.
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